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Documentation Updates 
The title page of this document contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software. 

To check for recent updates or to verify that you are using the most recent edition of a document, 
go to: 

      http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and log on. To register for an HP Passport 
ID, go to: 

      http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport log on page. 

You will also receive updated or new editions if you subscribe to the appropriate product support 
service. Contact your HP sales representative for details. 
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Support 
Visit the HP Software Support Online web site at: 

      http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support 
that HP Software offers. 

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued 
support customer, you can benefit by using the support web site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require a support contract. To register for an HP Passport ID, go to: 

      http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:  

      http://h20230.www2.hp.com/new_access_levels.jsp 
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Troubleshooting HP Service Health Reporter 
HP Service Health Reporter (SHR) is a cross-domain historical infrastructure performance 
reporting solution. It displays both top-down reports from Business Service Management (BSM) 
Business Service and Business Application or HP Operations Manager (HPOM) Node Group 
perspective to the underlying infrastructure. It also displays reports from the infrastructure to the 
impacted Business Services and Business Applications or Node Groups. It leverages the topology 
information to show how the underlying infrastructure health, performance, and availability are 
affecting your Business Services and Business Applications or Node Groups in the long term. 

Like any other enterprise application, SHR can experience problems in any IT environment. These 
problems occur because of the complex behavior of the application, changing hardware and 
software demands, and infrastructure changes. Troubleshooting SHR means identifying and 
diagnosing problems with the aim of keeping the application functioning optimally.  

About this guide 
This guide covers the common problems that you might encounter while using SHR and provides 
steps to troubleshoot them. Each problem is documented with a problem statement and the 
solution steps. The cause of the problem, if any, is explained in the solution. 

When to use this guide  

Use this guide when: 

• You have problems configuring and operating SHR. 

• You cannot view any data in the reports. 

• You notice alerts in the SHR Administration Console related to database connection, data 
collection, job streams, or services. 

How to use this guide 

This guide is organized into the following sections: 

• Troubleshooting Installation 

• Troubleshooting report-related problems 

• Troubleshooting administration problems 

Target audience and prerequisites 
The target audience for this guide is users who are working with SHR on a regular basis and 
administrators who are responsible for maintaining the product. The use of this guide assumes 
some prerequisite knowledge. Readers must have a high-level understanding of SHR and the 
various features and functions. They are expected to have read the following documents included 
with the product: 

• Installation and Configuration Guide 

• Concepts Guide 

• Online Help for Administrators 

• Online Help for Users 

• Release Notes 
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Introducing SHR log files 
This section covers the following two topics; 

• Configuring DEBUG levels in SHR log files 

• SHR log file inventory 

 

Configuring DEBUG levels in SHR log files 

Before you can effectively use a log file to troubleshoot a problem, you must have detailed 
information about that problem to be logged in the specific log file. By default, the log file only 
displays INFO, ERROR, or FATAL types of messages. For detailed information, you can configure 
SHR to log DEBUG or ALL types of messages in the log file. A DEBUG type of message provides 
additional information about a particular error that occurred rather than just a simple error or 
warning message. To set the DEBUG level for a log file, follow these steps: 

1. Open the BSMRLogConfigClient.xml file from the %PMDB_HOME%\Config folder. 

2. Search for a particular log file name. For example, to modify the level of the 
transform.log file, first search for the transform.log file. Each log file in SHR is 
associated with an Appender1 component in the BSMRLogConfigClient.xml file. 
Searching for the log file displays the <appender> tag for that log file. For the 
transform.log file, the following Appender component appears: 

 

3. Note the appender name for the log file. For example, for the transform.log file, the 
appender name is transformAppender as shown in the preceding example. 

4. Search for the appender name string in the file. The Logger component for the specified 
appender name is displayed. For example, for the transformAppender, the following Logger 
component appears: 

 

5. In the <logger> tag of the string, change the <level value> from INFO to DEBUG. 

6. Save the changes and close the file. 

1 A logging framework generates output for multiple destinations, such as outputting the trace 
statements to the console or serializing it into a log file. In SHR logs, a component called Appender 
is used to define this output medium. These components append themselves to the Logger 
component and relay the output to an output stream. 
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SHR Log file inventory  

SHR uses the log4j API for logging purposes. It maintains a log file for each of its modules, which 
is placed in the %PMDB_HOME%\log folder. The following table lists the log files available in SHR. 

The following table lists the installation log files and the locations. 

SR
# 

Log File Location on Disk Description 

1 activemq.log %PMDB_HOME%\log\ Log file for PMDB Platform Message Broker. This 
log file is located in the 
%PMDB_HOME%\activemq\data folder. 

2 Admin*.log %PMDB_HOME%\adm
inServer\logs 

Admin*.log 

3 Aggregate.log %PMDB_HOME%\log\ Contains log messages related to the loading of 
data from the rate tables to the hourly, daily, and 
forecast tables, and from the hourly tables to the 
daily tables. 
Appender: aggregateAppender 

4 audit.log %PMDB_HOME%\log\ Records the start times, end times, and durations of 
back-end processes. When a process begins, the 
file assigns a PID (process identification number), 
and then it records when the process ends, showing 
that the PID for the process was terminated. 

5 backend.log %PMDB_HOME%\log\ Contains log information for all the data processing 
job steps. 
Appender: backendLogAppender 

6 BOEInstall_0.log <SAP BOBJ Install 
Directory>\BusinessObj
ects Enterprise 
12.0\Logging\BOEInstal
l_0.log 
<SAP BOBJ Install 
Directory>\BusinessObj
ects Enterprise 
12.0\Logging\BOE_FP_
3_5_Install_0.log 

SAP Business Objects Installation log files. 

7 BSMRApp.log %PMDB_HOME%\log\ Application-wide log file that contains error 
messages from all the SHR modules except data 
processing. 
Appender: bsmrappender 

8 BSMRCollectionSe
rvice.log 

%PMDB_HOME%\log\ Log file for the PMDB Platform Collection Service. 

9 BSMRDBLoggerSe
rvice.log 

%PMDB_HOME%\log\ Log file for the PMDB Platform DB Logger Service. 

10 bsmrfrontend.log %PMDB_HOME%\log\ Contains log messages related to the Administration 
Console UI web application. 
Appender: BSMRFrontEndAppender 

11 Bsmrim.log %PMDB_HOME%\log\ Contains log messages related to the internal 
monitoring of data processing job streams, Sybase 
IQ database, Performance Management database 
(PMDB) platform, and Content Packs. 
Appender: BSMRIMAppender 

12 BSMRIMService.lo
g 

%PMDB_HOME%\log\ Log file for the PMDB Platform IM Service. 

13 BSMRService.log %PMDB_HOME%\log\ Log file for the PMDB Platform Administrator 
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SR
# 

Log File Location on Disk Description 

service. 
14 Catalina*.log %PMDB_HOME%\adm

inServer\logs 
 Contains log messages about the tomcat server 

15 collections.log %PMDB_HOME%\log\ Contains collection framework-related log messages 
such as data sources configured collection job 
scheduling and maintenance information. 
Appender: collectionAppender 

16 collectStep.log %PMDB_HOME%\log\ Contains log messages related to the collect step 
which moves data from {PMDB_HOME}/collect 
directory to {PMDB_HOME}/stage directory 
Appender: collectAppender 

17 cpDataMigrate.log %PMDB_HOME%\log\ cpDataMigrate.log 
Appender: cpDataMigrateAppender 

18 cpPatchAppender ${pmdb.home}/log/cppa
tch.log 

Patch installation log file. 

19 customgroup.log %PMDB_HOME%\log\ Contains log messages related to importing of 
custom groups defined in a XML file. 
Appender: customgroupAppender 

20 dbcollector.log %PMDB_HOME%\log\ Contains log messages related to database 
collection. 
Appender: dbCollectorAppender 

21 downtimeutility.log %PMDB_HOME%\log\ Contains log messages related to configuring 
downtime and enriching the performance data with 
configured downtime information. 
Appender: downtimeAppender 

22 dw_abclauncher.lo
g 

%PMDB_HOME%\log\ Contains log messages related to job streams. Log 
messages specific to a process can be seen in the 
process specific log file. For example, loader.log for 
the loader process. 
Appender: abclauncher-RollinglogFileAppender 

23 Host-manager*.log %PMDB_HOME%\adm
inServer\logs 

Host-manager*.log 

24 hpacollector.log %PMDB_HOME%\log\ Contains log messages related to HP Performance 
Agent collection. 
Appender: hpaCollectorAppender 

25 IQ15Console.log %USERPROFILE%\IQ
15Console.log 

If you have installed Sybase IQ remotely, the log file 
is available at the following location on the remote 
system: %temp%\..\HPOvInstaller\HP-SHR-
SybaseIQ_9.20\ 

26 Jakarta_service_*.l
og 

%PMDB_HOME%\adm
inServer\logs 

Jakarta_service_*.log 

27 License.log %PMDB_HOME%\log\ Contain messages for license-related tasks. 
Appender: licenseAppender 

28 loader.log %PMDB_HOME%\log\ Contains log messages related to data loading from 
the stage area to the data store. 
Appender: LoaderAppender 

29 Localhost*.log %PMDB_HOME%\adm
inServer\logs 

Contains log messages related to Server Access 

30 Manager*.log %PMDB_HOME%\adm
inServer\logs 

Manager*.log 

31 mapperStep.log %PMDB_HOME%\log\ Contains log messages related to transformation of 
collected data. Transformation includes pivot 
transform, rows filtering, etc. 
Appender: mapperAppender 
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SR
# 

Log File Location on Disk Description 

32 metadata.log %PMDB_HOME%\log\ Contains log messages related to metadata 
repository persistence, access, and modification. 
Appender: MetadataRepositoryAppender 

33 myBsm.log %PMDB_HOME%\log\ Contains log messages related to launching of SHR 
reports from MyBSM console. 

34 OvInstallerLog.txt %temp%\..\HPOvInstall
er\HP-SHR_9.20\HP-
SHR_9.20_<timestamp
>_HPOvInstallerLog.ht
ml 
%temp%\..\HPOvInstall
er\HP-SHR_9.20\HP-
SHR_9.20_<timestamp
>_HPOvInstallerLog.txt. 

This folder also stores log files for each component 
of SHR such as LCore components, OVPerl, and so 
on. 

35 packagemanager.lo
g 

%PMDB_HOME%\log\
packagemanager.log 

Appender: pkgmgrAppender 

36 Pmdb.iqmsg <Sybaseiq DB path> SybaseIQ log file information 
37 Postgresql-<date 

and time>.log 
Postgresql-<date and 
time>.log 

PostgreSQL log file information 

38 Postgresql-<date 
and time>.log 

%PMDB_HOME%\log\ Log file for the PostgreSQL service. 

39 postinstallconfig.log %PMDB_HOME%\log\ Details on database schema creation on Sybase IQ, 
details on SHR Management database schema 
creation on Postgresql. 
Appender: postinstallAppender 

40 reconcileStep.log %PMDB_HOME%\log\ Contains log messages related to reconciliation of 
collected data. 
Appender: reconcileAppender 

41 reloadAppender ${pmdb.home}/log/reloa
d.log 

Log file for the contrib utility (reload.exe) that 
handles reload of failed data. 

42 shiftmaint.log %PMDB_HOME%\log\ Contains log messages related to populating the 
shift fact tables based on shift configured in Admin 
UI. 
Appender: shiftMaintAppender 

43 stage.log %PMDB_HOME%\log\ Contains log messages related to data staging, and 
purging of staging area. 
Appender: stageAppender 

44 Stderr*.log %PMDB_HOME%\adm
inServer\logs 

Contains messages logged to standard error by the 
tomcat server 

45 Stdout*.log %PMDB_HOME%\adm
inServer\logs 

Contains messages logged to standard output by 
the tomcat server 

46 SybaseService.log %PMDB_HOME%\log\ Log file for the PMDB Platform Sybase Service. 
47 SybaseService.log %PMDB_HOME%\log\  Contains error/log messages related to starting of 

Sybase IQ database from windows service manager 
48 topologycollector.lo

g 
%PMDB_HOME%\log\ Contains log messages related to topology 

collection. 
Appender: topologyCollectorAppender 

49 trend.log %PMDB_HOME%\log\ Contains messages for all of SHR’s back-end 
processes. Each message specifies the start and 
end times for the logged process. 

50 Trend.log %PMDB_HOME%\log\ Log file for PMDB Platform Timer service. 
51 Trendtimer_dbg.log %PMDB_HOME%\log\ Contains log messages related to SHR timer 

service. 
52 VC_collector/collect

or.log 
${pmdb.home}/log/VC_
collector/collector.log 

VC Collector logfiles 
Appender: vcAppender 
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Troubleshooting Installation 
This section of the guide covers the possible problems that can cause the SHR installation to fail 
and how you can troubleshoot them. 

Symptom: Installation fails with BO Rebrand error 

Description: Installation fails with BO Rebrand Error.  

Cause1: Postgres install failed with non-zero error code.  

Ensure you are have local admin user rights and are not logged into the system as a domain user. 

Symptom: Installation failure caused by SAP BOBJ error 

Description: While running the HP Software Installer, the installation fails and the following error 
message is displayed: 

SAP BusinessObjects is installed on the system. Please Uninstall 
it before installing HP SH Reporter.  

Resolution: If you have any component of SHR (such as SAP BOBJ or Sybase IQ), pre-installed 
or not cleanly uninstalled in a previous un-install on your system, the SHR installation will fail as the 
Installer tries to install the components that are bundled with the product. 

To resolve this problem, you must clean up the existing components from the system and re-run 
the Installer again (in case it is a virtual system, it is recommended to re-image the VM if feasible). 

Symptom: Unable to bring up SHR Services after successful 
Installation 

Description: If SHR is installed on a virtual machine that is not restarted after the installation, the 
environment variables set by the installer will not be available to the user. As a result, SHR 
services will not start despite multiple retries. 

Resolution: After installing SHR, ensure you restart the virtual machine. 

Symptom: Remote Sybase IQ database creation fails 

In the HP Service Health Reporter Configuration wizard, while trying to create the Sybase database 
file on a remote system, the post-installation procedure fails and the following error message 
appears: 

<time stamp>,018 ERROR, 
com.hp.bto.bsmr.dao.helper.CreateSybaseIQDatabase.executeSQL, 
Could not connect to the database.  

<time stamp>,049 ERROR, 
com.hp.bto.bsmr.dao.helper.CreateSybaseIQDatabase.executeSQL , 
Specified database not found  

Resolution 1: This error occurs if the database file location specified in the HP Service Health 
Reporter Configuration Wizard includes space in the file path. To resolve this problem, on the 
remote system, make sure that the specified database file location exists on the remote system. In 
addition, make sure that the path provided in the Post-Install wizard does not contain any spaces. 
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Resolution 2: This error can occur in case there is no adequate disk space on the drive. The 
installer does not warn in the remote database scenario. Increasing the disk space should help you 
resolve the issue. 

Resolution 3: Apply the hotfix SHR_92_HF_REMOTE_SYBASE_SERVICE for creating the 
Sybase IQ as a Windows service. 

 

Symptom: Database schema creation takes a long time (post-
installation Step 3) 

Description: During the post-installation configuration stage, on the Create Database Schema 
page of the Administration Console, clicking the Next button after typing the required values has no 
effect and the users have to wait for a long time for the process to complete. 

Resolution 1: Clear the web browser cache, reload the page, and perform the steps again. 

Resolution 2: If the database is on a remote system, apply the hot-fix 
‘SHR_92_HF_REMOTE_SYBASE_SERVICE’ for creating the Sybase IQ as a Windows service. 

Symptom: Unable to log on to the Administration console 

Description: After typing in the user credentials in the Administration console Login screen and 
clicking the Log in button, the following error message appaers: 

 

Resolution: Clear the web browser cache, reload the page, and perform the steps again. 

 

Symptom: Error seen in the Administration console  

Description: At times, the Administration console does not work properly. After opening the 
console, the following Windows error message appears: 

Page 15 of 52 



Troubleshooting Guide 
Troubleshooting HP Service Health Reporter 

 

Resolution: Clear the web browser cache, reload the page, and perform the steps again. 

Symptom: Content Pack uninstallation fails 

Description: When removing the Content Packs, the uninstallation process fails and the following 
error message is displayed in %PMDB_HOME%\log\trend.log: 

SQL Anywhere Error -210: User 'pmdb_admin' has the row in 
'<table_name>' locked  

This failure occurs when one or more database connections have a shared lock on a database 
stage table. 

Resolution: Follow these steps: 

To verify if the tables are locked, perform the following steps: 

1. Click Start > Programs > Sybase > Sybase IQ 15.3 > Interactive SQL Java. The 
Interactive SQL Java console opens. 

2. In the Connect dialog box, on the Identification tab, select Supply user ID and password. 

3. Type the user name and password and then press OK. 

4. Under SQL Statements, type sp_iqlocks, and then click the Execute all SQL statement(s) 
button to run the command. 

If there are locked tables, there could be a other SQL sessions open that you should close. If there 
are no locked tables, you can proceed with the removal of the Content Packs. 

 

Symptom: SHR uninstallation fails 

Description: Uninstalling of SHR may not have un-installed Sybase IQ Server cleanly. 

Resolution: Uninstall Sybase IQ Server Suite 15.3 (64-bit) manually and restart your system. 
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Troubleshooting report-related problems 
SHR provides an interactive user interface—the SAP BOBJ InfoView interface that runs on your 
browser—to view the available reports. The reports are generated by running a query on the 
underlying data. At times, if the data is missing or there is a problem with SAP BOBJ, the report 
might not display any data. 

This section of the guide covers the possible problems that lead to missing data in the reports and 
how you can troubleshoot them. 

Symptom: Report opens with a “No Data” pop-up message 

Description: After opening a report and specifying the prompts, a window appears with a message 
"No data to retrieve in the following Queries." For example, consider a WebLogic 
report such as WebLogic EJB Top 10 Pool report. The following figure shows the message that 
appears. 

 

 

 

Resolution: This problem could be due to issues at the ETL layer (Extract, Transform, and Load) 
or due to issues with data not being available in the data source itself. 

The following flow chart below provides you the steps you will need to follow to troubleshoot the 
possible causes for no data in reports error. 
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P  
(Ping) 

If test connection failed then the reach ability to the data source needs to be 
verified. Check if all the required services on the source are running. Refer to Data 
source Troubleshooting section. 
If test connection is successful, refer to “D”. 

D 
(Datasource) 

There is no data available on the source. Refer to Data source Troubleshooting 
section. 

C 
(Collect) 

Symptom: 
The COLLECT step for the stream shows ERROR (Red icon) and files are getting 
piled up in {PMDB_HOME}/collect folder.  
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Contact HP Support if this is your scenario. There are no known cases when this 
should fail. 

T 
(Transform) 

Symptom: 
The TRANSFORM step for the stream shows ERROR (Red icon) and relevant files 
are getting piled up in {PMDB_HOME}/failed_to_tranform folder. Refer to Appendix 
to identify the metadata for the step of a stream. 
Contact HP Support if this is your scenario. There are no known cases when this 
should fail.  

R 
(Reconcile) 

Symptom: 
The RECONCILE step for the stream shows ERROR (Red icon) and relevant files 
are getting piled up in {PMDB_HOME}/failed_to_reconcile folder. Refer to Appendix 
to identify the metadata for the step of a stream. 
Resolution: 
Refer to the Data source Troubleshooting section. 

S 
(Stage) 

Symptom1:  
The STAGE step for the stream shows ERROR (Red icon). Drill down detail, the 
following message is displayed "Database server not found". Also, relevant files are 
getting piled up {PMDB_HOME}/stage folder. Refer to Appendix to identify the 
metadata for the step of a stream. 
Resolution: 

1. This can be due to temporary loss of connection to database and the next 
run of the step takes care of reprocessing data. 

2. If the files are getting piled up in stage directory check the connectivity to 
the database. Refer to the Database Alerts Section. 

 
Symptom2: 
The STAGE step for the stream shows ERROR (Red icon). Drill down detail, the 
following message is displayed "You have run out of space in pmdb_user_main 
DBSpace". Also, files are getting piled up {PMDB_HOME}/stage folder. 
 Resolution: 

1. Increase the disk space if the drive is running full 
2. Increase the pmdb_user_main DB Space manually and start the 

HP_PMBD_Internal_Monitoring service in case the service is stopped or 
disabled. 

 
Symptom3: 
The STAGE step for the stream shows ERROR (Red icon). Drill down detail, the 
following message is displayed “Insufficient buffers for". Also, files are getting piled 
up {PMDB_HOME}/stage folder.  
This error is because the temp cache is not adequately provisioned.  
Resolution: 
You can ignore this error if it’s happening occasionally. If the step is failing 
frequently, consider following options; 

1. Refer to the Performance Sizing guide for temp cache configurations. 
2. Reduce the number of concurrent jobs to be launched. Refer to the online 

help for Administrators. 
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L, A, S 
(Load, 
Aggregate, 
SQL 
Executor) 

Symptom1:  
The LOAD/AGGREGATE/EXEC_PROC step for the stream shows ERROR (Red 
icon). Drill down detail, the following message is displayed "Database server not 
found”. 
Resolution: 

1. This can be due to temporary loss of connection to database and the next 
run of the step takes care of reprocessing data. 

 
Symptom2: 
The LOAD/AGGREGATE/EXEC_PROC step for the stream shows ERROR (Red 
icon). Drill down detail, the following message is displayed "You have run out of 
space in pmdb_user_main DBSpace".  
Resolution: 

1. Increase the disk space if the drive is running full 
2. Increase the pmdb_user_main DB Space manually and start the 

HP_PMBD_Internal_Monitoring service in case the service is stopped or 
disabled. 

 
Symptom3: 
The LOAD/AGGREGATE/EXEC_PROC step for the stream shows ERROR (Red 
icon). Upon Drilling down, the following message is displayed “Insufficient buffers 
for” and data is stuck in source tables. Refer to reference section to identify the 
metadata for the step of a stream. 
This error is because the temp cache is not adequately provisioned.  
Resolution: 
You can ignore this error if it is not happening too frequently. If the step is failing 
frequently, consider following options; 

1. Refer to the Performance Sizing guide for temp cache configurations. 
2. Reduce the number of concurrent jobs to be launched. Refer to the online 

help for Administrators. 
I 
(Identify 
Streams) 

Refer to Report to Stream Mapping to identify the stream associated with the report 
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Symptom: Unable to refresh a report 

Description: You cannot refresh the report to display updated information because the cascading 
prompt value in the Prompts dialog box is missing. For example, consider a WebLogic report, 
WebLogic EJB Cache Hit report. The following figure shows the problem that might occur when 
trying to refresh the report. 

 

Resolution: This problem occurs because of missing data in the dimension tables for a query. To 
troubleshoot this problem, follow these steps: 

Note: The following steps are performed using the WebLogic EJB Top 10 Pool report as an 
example but you can perform these steps for any report. 

1. Check the dimension table for data for the query: 

a. Click Cancel in the Prompts window. 

b. On the report toolbar, click the Edit button.  

c. If a Warning - Security message box appears, click Yes. The report opens in Edit mode. 

d. On the toolbar, click Edit Query. 

e. At the bottom of the report, click EJB Monthly, and then click the View SQL button. The 
SQL Viewer dialog box opens, which displays the SQL for that query. Note that EJB Monthly is 
used as an example here. For any other report, you must edit the respective query. 

f. Identify the dimension table from which the EJB name is fetched. In this example, the dimension 
table is K_CI_J2EE_Server. 

2. Access the database on which you want to check the presence of data: 

a. Click Start > Programs > Sybase > Sybase IQ 15.3 > Interactive SQL Java. The Interactive 
SQL window and the Connect dialog box opens. 

b. In the Connect dialog box, on the Identification tab, type the user ID and password to access 
the database. 

c. In the Server name box, type the name of the database host. Otherwise, click Find to search of 
the database host. The Find Servers dialog box opens. 

d. Select the database that you want to connect to and then click OK. 

e. Click OK. 

3. Run the following command in the Interactive SQL Java window to check for data in the dimension 
table: 

select * from <dimension table name>  
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In this example, the <dimension table name> is K_CI_J2EE_Server. 

4. If no data is present in the database, you must verify with the source and if required, debug the 
collected CSVs and the respective stage tables. For the steps to perform these tasks, see Report 
displays partial or no data. 

 

Symptom: Report appears blank (after report refresh)  

Description: After opening a report and applying the necessary prompts, the report does not 
display any data. The following figure shows a sample blank report: 

 

 

Resolution: The report does not display any data because you might not have selected the time-
drill filters for the report and you might not have selected the right combination of the Prompts.  

To resolve this problem, follow these steps: 

1. Select the correct combination of the prompts in the Prompts dialog box: 

a. On the main toolbar, click Refresh All. The Prompts dialog box opens. 

b. In the Reply to prompts before running the query box, select a prompt, and then in the listed 
prompt values, select the appropriate value(s). 

c. Perform the above step to each of the displayed prompts. You can try selecting different 
combination of prompts. 

d. After selecting the prompt values, click Run Query. 

2. Set the time-drill filters on the Report Filter toolbar, if they are available for the report: 

a. In the Select Year list, select a specific year for which you want to view the data. 

b. In the Select Month list, select a specific month for which you want to view the data. 

c. If there are context-based filters available on the Report Filter toolbar, select the appropriate 
value from the drop-down list. 

Reports might appear blank because of issues in the database such as missing business keys, 
table not getting loaded, and so on. To investigate such errors, contact HP Support. 
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Symptom: Data missing for specific time period 

Description: A selected report displays data for a particular time period even when drilled down to 
the day level, such as 6th September, 2010. However, when the time period is changed to 11th 
September, 2010, the report does not display any data. 

Resolution: This problem occurs because of missing data. You must check each variable used in 
the report and the corresponding query from where the data is retrieved for the presence of data. 
Perform the following steps: 

1. Identify the queries for the variables in the report: 

a. On the report toolbar, click Edit. 

b. If a Warning - Security message box appears, click Yes. The report opens in Edit mode. 

c. On the toolbar, make sure that Edit Report is selected. 

d. Click the  icon to display the Formula Toolbar. 

e. To select the variable, in the report pane: 

i. For a tabular report, click the column with missing data. The Formula Editor displays 
the variable name. 

ii. For a graph, click the View Structure button. The variable names are displayed on 
the report. 

f. On the left pane, on the Data tab, double-click the variable name. The Variable Editor 
opens. 

g. In the Variable Editor dialog box, in the Formula box, identify the queries for which the 
data for the selected variable is retrieved. For example, in the WebLogic EJB Cache Hit 
report, the formula for the Avg EJB Cache Hit % is: 

=If(Match([Level];"Year");[EJB Monthly].[avg EJB Cache Hit 
Percent];If(Match([Level];"Month");[EJB Monthly].[avg EJB 
Cache Hit Percent];If(Match([Level];"Day");[EJB Daily].[avg 
EJB Cache Hit Percent];If(Match([Level];"Hour");[EJB 
Hourly].[avg EJB Cache Hit Percent]))))  

Note that the corresponding query for the Avg EJB Cache Hit % variable is 
EJB Hourly. 

2. Run the SQL query for the query and check for data in the database. If no data is present in 
the database, you must verify with the source – refer to the Data Source Debugging section 
for more details.  

Symptom: No data on SPI data source reports 

Description: This symptom is applicable to Microsoft SQLServer/Oracle/WebSphere/WebLogic 
reports that do not display any data. 

Resolution: This problem is because of data logging issue with HP Performance Agent when both 
HP Operations agent and HP Performance Agent are installed in your environment. The table 
below consists of the datasources which the content pack uses. It is due to improper 
summarization of metric Id and value ID, these reports would not show data. 
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To resolve this, use the HP Operations agent for data logging instead of the HP Performance 
Agent. 

Content Pack Name Data Sources (HP – Performance Agent) 
Oracle DBSPI_ORA_REPORT; DBSPI_ORA_GRAPH 
MS SQL DBSPI_MSS_REPORT; DBSPI_MSS_GRAPH 
WebLogic WBSSPI_METRICS ;WBSSPI_RPT_METRICS  
WebSphere WLSSPI_METRICS ; WLSSPI_RPT_METRICS  
Active Directory ADSPI 
Exchange 2007 EX2007_DATA 
Exchange 2010 EXSPI_DATA 

  

For more information and the resolution steps for SQL Server and Oracle reports, see the 
Troubleshooting Data Logging with HP Performance Agent section under Chapter 7 of the SPI for 
Databases 12.04 Installation and Configuration Guide.  

For more information and the resolution steps for WebLogic reports, see the Integrating WebLogic 
SPI with HP Performance Agent section under Chapter 3 of the SPI for WebLogic Application 
Server 7.04 Installation and Configuration Guide. 

For more information and the resolution steps for WebSphere reports, see the Integrating 
WebSphere SPI with HP Performance Agent section under Chapter 3 of the SPI for WebSphere 
Application Server 7.04 Installation and Configuration Guide. 

Incase the issue is not resolved – refer to the Data Source Debugging section for more details. 

Symptom: SAP BOBJ Errors 

This section covers some of the common SAP BOBJ-related errors encountered in SHR and the 
steps to troubleshoot them. These errors might prevent the reports from opening or showing data. 
In addition to these errors, SAP BOBJ provides a detailed list of errors for Web Intelligence reports 
at the following URL, http://help.sap.com/businessobject/product_guides/errors/12/0/en/html/. 

SAP BOBJ Central Management Console error 
Description: When trying to access the SAP BOBJ Central Management Console, the following 
error message appears: 

 

 

Resolution: This error occurs when the specified port, that is, 6400 in the preceding sample 
image, is locked by another web service. To resolve this issue, you must follow these steps: 
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1. Click Start > Programs > BusinessObjects XI 3.1 > BusinessObjects Enterprise > 
BusinessObjects Enterprise Central Management Console. The Central Management Console 
page opens. 

2. Enter the username and password and click Log On. The CMC Home page opens. 

3. Under Organize, click Servers. The Servers page opens. 

4. Under Server Name, note the servers that are disabled.  

5. Right-click the disabled server and then click Enable Server. Perform this step for all disabled 
servers. 

SAP BOBJ InfoView login error 
Description: On the SAP BOBJ InfoView login screen, after typing the correct user credentials and 
clicking Log On, the following error message appears: 

 

Resolution: This error occurred because your SHR license expired. To check the status of the 
license, see the Licensing page in the Administration Console. If the license has expired, you must 
renew the license, apply for a permanent license, or contact HP Support for assistance. For more 
information, see the "Managing licenses" section in the Online Help for Administrators guide. 

Report timeout error 
Description: While performing an action on an opened report, such as changing the prompts, 
selecting the filters, or accessing the report tabs, the following error message appears: 

 

Resolution: This error occurs when a Web Intelligence session is opened and kept idle for a long 
time. To resolve this, click Document List and reopen the required report.  

Database error 
Description: While opening a report, the following error message appears: 

Page 26 of 52 



Troubleshooting Guide 
Troubleshooting HP Service Health Reporter 

 

 

Resolution: This error occurs when the connection parameters for the SAP BOBJ Universe, where 
the reports are hosted, do not connect to the proper Sybase IQ database instance server. To 
resolve this issue, make sure that the respective Universe is connected to the proper database. 
Follow these steps: 

1. Click Start > Programs > BusinessObjects XI 3.1 > BusinessObjects Enterprise > Designer. 
The SAP BOBJ Universe Designer opens. 

2. In the User Identification dialog box, click OK. 

3. On the File menu, click Open. The Open dialog box appears. 

4. Select the respective Universe corresponding to the report for which the error was generated. For 
example, if the report belongs to System Management, select the System Management Universe.  

5. Click Open. 

6. On the File menu, click Parameters. The Universe Parameters dialog box opens. 

7. Click the Definition tab 

8. Click Edit to edit the connection parameters. The Edit <connection type> connection dialog box 
opens. 

9. In the Data source name field, select BSMR. 

10. Click Next twice and then click Finish. 

Internal error 
Description: While opening a report, one of the following error messages appears: 
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Resolution: This error occurs because the utilization of the system resources as well as SAP 
BOBJ internal services was very high at that particular moment when the Web Intelligence report 
was accessed. The SAP BOBJ services were in a waiting state for that moment when the report 
was accessed. To resolve this issue, click OK in the message box and refresh the report. 
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Troubleshooting administration problems 
The SHR Administration Console is a web-based monitoring tool that you can use to monitor the 
various components of SHR, such as data collection, data processing, database, services, and so 
on. In the event of a problem, appropriate alerts are displayed on the Administration Console.  

This section of the guide covers how to troubleshoot the alerts that appear on the Administration 
Console. In addition, this section covers some of the commonly encountered problems during data 
collection, data reconciliation, data processing, or while performing certain administrative tasks. 

The Home page of the Administration Console gives you an overall view of the status of SHR, its 
associated services, the database, and the host platform. 

Figure 1: The Home Page 

 

In the event of a problem with an SHR component, the Home page displays an alert icon, so that 
you can investigate and take the appropriate action. 

This section of the guide covers the following SHR component-related alerts and the steps you 
must perform to resolve them: 

• Understanding data collection alerts 

• Understanding ABC alerts 

• Understanding service alerts 

• Understanding database alerts 

Data 
Collection 
Alerts 

ABC 
Alerts 

Service 
Alerts 

Database 
Alerts 
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Understanding data collection alerts 

The Home page of the Administration Console monitors and displays the status of the data 
collection by SHR from the various data sources, such as Run-time Service Model (RTSM), HP 
Operations Manager (HPOM), Business Service Management (BSM) database, and 
HP Performance Agent (PA).  

Figure 2: The Collection Status Pane 

 

There are two types of collection status information displayed in the Collection Status pane of the 
Home page, indicated by the following icons: 

•  Indicates that the collection from the specific data source failed. 

•  Indicates that the collection never started from the specific data source. 

For detailed information about the collection status, you can click the hyperlink of the data source 
type in the Collection Status pane to open the respective data source page. For example, clicking 
RTSM opens the Service Definition page. 

This section of the guide explains the possible problems that might cause the collection to fail and 
the steps you must take to resolve these problems. 

Symptom:  Data collection has not started or failed 

Description: The Collection Status pane on the Home page lists the RTSM or HPOM data source 
in the   column. This indicates that the topology collection never started from these data sources. 

Resolution: The data source that you are trying to connect to might be down and therefore, no 
connection is established. To resolve this problem, follow these steps: 

1. Check the connection status: 

A. RTSM, HP OM 

In the Administration Console, go to the Topology Source> Service Definition page to check 
the status for the RTSM or HPOM data source. 

B. ProfileDB, OMi, HPOM 

In the Administration Console, go to the Collection Configuration 
> ManagementDB/ProfileDB page to check the status for the ProfileDB data source. Similarly, 
for OMi, go to the OMI page and for HPOM, go to the Operations Manager page 

C. Performance Agent 

In the Administration Console, go to the Collection Configuration > PA Data Source page to 
check the status for the PA data source. 

Click Test Connection to test the data source connection (double check the credentials using the 
configure option).  In case the Test Connection fails for any of the above scenarios, refer to the 
Data source Troubleshooting section.  
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Understanding ABC Alerts 

To troubleshoot data processing-related problems, you can start on the Home page of the 
Administration Console. The ABC Alerts table on this page displays a list of the 10 latest active 
data processing alerts encountered by the SHR workflow framework.  

Figure 3: ABC Alerts 

 

There are two types of alerts generated by the workflow framework: 

• Errors—This alert is generated when an active job stream fails to complete the execution process 
because of a serious error in a job step. This halts the execution of the job stream. 

• Maximum execution time exceeded—This alert is generated when a job step fails to complete 
running within the defined execution time frame. 

Viewing details of the alert  

To view details of the displayed alert, click the hyperlink in the Step Name column of the table. An 
alert details window opens. 

Figure 4: Alert Details Window 

 

In this alert details window, you can view the detailed error message, the command that was run 
when the error occurred, the remaining and the maximum number of retries, the maximum 
execution time, and the start and end times. If the job step continues to fail until the maximum 
number of retries is reached, the status of the stream will remain as error and will no longer be 
active. During the retry phase, if the maximum execution time is exceeded, the status of the stream 
changes to MAX_EXEC_TIME_EXCEEDED and will no longer be active. In this situation, the End 
Time will display NULL as the value. 

The alert details window does not appear for those alerts that are caused by maximum execution 
time exceeded. You cannot click the Step Names for these alerts to open the details window. For 
more information on these alerts, you must go to the Data Processing page. 

Performing additional troubleshooting tasks 

• ABC alert - MAX_EXEC_TIME_EXCEEDED 

• ABC alert - ERROR 
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Symptom: ABC alert - ERROR (Max exec time exceeded) 

Description: On the Data Processing page of the Administration Console, the Step Status column 

displays the   indicator for a particular job step. Checking the status of the job step 
shows the MAX_EXEC_TIME_EXCEEDED alert. 

Cause: This alert is generated when the job step failed to complete executing within the defined 
execution time frame. To troubleshoot this type of error, perform the following steps: 

1. On the Data Processing page, click the job step icon in the diagram to open a detailed message 
box about that job step. 

2. Note the Process ID of the job step. 

3. Browse to %PMDB_HOME%\log folder and open the dw_abclauncher.log file. 

4. Search for the Process ID in the log file. 

5. Note the operating system PID of the job step. For example, an entry in the log file might look like: 

2010-11-23 02:50:12,522 INFO [com.hp.bto.dw.common.log.DwLog] - 
Started step 'DataLoad_Oracle_DiskSort' of stream 
'Database_Oracle@Facts_DiskSort' with Process ID = 
119615[PID:35408]  

In this example, the PID for the job step is 35408. 

6. Validate this operating system PID with an operating system utility to check whether the process is 
running or not. For example, you can check for the process in the Processes tab of the Windows 
Task Manager window. 

7. If the process is listed as active in the Windows Task Manager, perform any of the following steps: 

 Wait for the job step to complete.  

 If the job step execution does not complete after a day or two or if there is a problem with the job 
step corresponding to the PID according to the log file, end the process using the operating 
system utility and contact HP Support for assistance. 

8. If the process is not listed in the operating system utility, wait for the workflow framework to rerun 
the job step. If the status continues to show Error, contact HP Support. 

Symptom: ABC alert – ERROR (Max retries exceeded) 

Description: On the Data Processing page of the Administration Console, the Step Status column 

displays the   indicator for a particular job step. Checking the status of the job step 
shows the ERROR alert. 

Resolution: This alert is generated when the job step failed to complete executing because of an 
error. To troubleshoot this type of error, perform the following steps: 

1. On the Data Processing page, click the job step icon in the diagram to open a detailed message 
box about that job step. 

2. Note the Max Retries and Remaining Retries fields. 

3. If the Remaining Retries is zero, perform the following steps to abort the job stream: 

a. Click Start > Run. The Run dialog box opens. 

b. Type cmd in the Open field, and then press ENTER. The Command Prompt window opens. 
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c. Type the following command to abort the job stream: 

abcBatchControl -abort -streamId <stream name> 

In this instance, <stream name> is the name of the job stream. 

Understanding service alerts 

The Service Status pane on the Home page shows the  icon for the SHR service status. This 
status indicates that the services are currently not running.  

Figure 5: Service Status Pane on the Home Page 

 

To investigate the problem further, you must check the Services page, where you can get the 
detailed information of the status of each SHR service.  

Figure 6: Services Page in the Administration Console 

 

In case of Error/Warning status against the “HP PMDB Platform Collection”, ensure you have 
adequate free disk space on the drive where SHR is installed (at least 15% free space of total disk 
space). 

If any of the service listed above shows error, restart the service from using the Start/Stop link 
provided or via the Windows Service panel. In case you have trouble restarting the service or in 
case the service is going down frequently, contact HP Support. 
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Understanding database alerts 

Using the Home page of the Administration Console, you can monitor the status of the SHR 
database connection, the availability, and space usage of the database. In the event of any 
problems, appropriate alerts are displayed in the following sections of the Home page: 

• Database Status—This pane displays the status of the database connection. In case the connection 
to the database cannot be established, the  status icon is displayed. 

• Database Alerts—This table displays a list of the database-related warning or errors messages.  

For detailed information about the database, you can check the Database Monitoring page in the 
Administration Console. 

Figure 7: The Database Monitoring Page 

 

This section explains how to troubleshoot these database-related alerts. 

Symptom: Database alert on home page 

Description: The Database Alerts table on the Home page displays the message "Error while 
creating new db space file={0}.iq at the location {1}." 

Resolution: When 70 to 85 percent of the database space is used up, a warning message is 
generated in the Database Alerts table. At the same, SHR automatically resolves this database 
space issue by creating a new database space file. However, if a problem occurs during the 
creation of the database space file, this error message is generated.  

Currently, the new database file is created in the same folder where the Sybase IQ database files 
exist. If the drive does not have enough space, the above error occurs. To resolve this problem, 
check the disk space and add more according to your requirements or manually create the new 
database file in another drive. 
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Symptom: Database connection failure 

Description: The Database Status pane on the Home page of the Administration Console shows a 
 icon. 

Resolution: Restart the database (re-start HP_PMDB_Platform_Sybase service from Windows 
Service panel). In case you have trouble restarting the service or in case the service is going down 
frequently, contact HP Support. 

Note: If Sybase IQ is installed on a remote system, you must perform these steps on the remote 
system. The name of the Sybase IQ service might be different from the one mentioned in the steps 
as it depends on the name that was defined when the service was first created in the remote 
system.  

Symptom: Job streams not being loaded or run 

Description: After installing the Content Packs and configuring SHR to collect data, you notice that 
the Data Processing page of the Administration Console does not display any active streams. The 
job streams are not being loaded or run. 

Resolution: Ensure the HP_PMDB_Platform_Timer service  is running.  

Symptom: Unable to log on to SAP BOBJ InfoView from a virtual 
machine 

Description: After launching the SAP BOBJ InfoView from the Administration Console on a virtual 
machine, you are not able to log on to it even after providing the correct user credentials. 

Resolution: This problem occurs if SHR is installed on a virtual machine and at the time of 
installation, the host name on the virtual machine is not correctly set. The HP Software installer 
configured SAP BOBJ using the incorrect host name. However, the installer used correct host 
name in the %PMDB_HOME%/data/config.prp file. Ideally, the installer should use the same 
host name across all components. 

To resolve this problem, perform the following steps: 

1. Click Start > Programs > BusinessObjects XI 3.1 > BusinessObjects Enterprise > Central 
Configuration Manager. The Central Configuration Manager window opens. 

2. Right-click Apache Tomcat 5.5.20, and then click Stop to stop the Tomcat service. 

3. Right-click Server Intelligence Agent (HOML01GEATON) and then click Stop to stop the 
SIA service. 

4. Right-click Server Intelligence Agent (HOML01GEATON) and then click Properties. The Server 
Intelligence Agent (HOML01GEATON) Properties dialog box opens. 

5. On the Configuration tab, select the Change Cluster Name to check box, and then type the new 
name of the virtual or physical machine. 

6. Click OK. 

7. Right-click Server Intelligence Agent (HOML01GEATON) and then click Start to restart the 
SIA service first. 

8. Right-click Apache Tomcat 5.5.20 and then click Start to restart the Tomcat service next. 

9. Close the Central Configuration Manager window. 

10. In the Administration Console, click Administration > SAP BOBJ. The SAP BOBJ page opens. 

11. Click Launch InfoView. The BusinessObjects InfoView Login page opens. 
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Symptom: Sybase IQ process still runs after service is stopped 

Description: Stopping the PMDB Platform Sybase service when the Sybase IQ database is down 
does not ensure that the Sybase IQ process (iqsrv15.exe) stops running. 

Resolution: To resolve this problem, you must manually stop the Sybase IQ process after stopping 
the PMDB Platform Sybase service. Perform the following steps: 

1. Stop the Sybase IQ process (iqsrv15.exe) from the Task Manager. 

a. On the desktop, right-click the taskbar, and then click Task Manager. The Windows Task 
Manager window opens. 

b. Click the Process tab. 

c. Select the Show processes from all users check box and then locate the iqsrv15.exe process in 
the displayed list of processes. 

d. Select the iqsrv15.exe process and then click End Process. 

Note: If Sybase IQ is installed on a remote system, you must perform these steps on the remote 
system. The name of the Sybase IQ service might be different from the one mentioned in the steps 
as it depends on the name that was defined when the service was first created in the remote 
system. For more information, see the Installation and Configuration Guide chapter 4, "Configuring 
SHR." 

Symptom: Administration Console web page error  

Description: While trying to log in or browse through the Administration Console, the following 
error message is displayed on the web page: 

An Error Occurred:  

duplicate Id for a component 
cp_installed:cp_installed_table:j_id61  

about:blank#  

java.lang.IllegalStateException: duplicate Id for a component 
cp_installed:cp_installed_table:j_id61  

at 
org.ajax4jsf.application.TreeStructureNode.apply(TreeStructureNode
.java:68)  

at 
org.ajax4jsf.application.TreeStructureNode.apply(TreeStructureNode
.java:92)  

Resolution: This error occurs because of duplicate IDs that were created for the same web page. 
To resolve this, clear the web browser cache and refresh the page. 
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Troubleshooting data source-related issues 
Troubleshooting HP Operations agent data source issues 

How to check data availability on the HP Operations agent node using 
ovcodautil 

Set the environment variable in the cmd prompt to get additional options 
C:\>SET CODAMAGIC=0x05201993 

 
1. To dump latest data in the datasource for all instances 

Command: ovcodautil –dumpds <datasource> 
Example:  ovcodautil –dumpds SCOPE 

 
2. To dump metric list of a data source and a class 

Command: ovcodautil –ds <datasource> –o <class> –n <hostname> -obj 
Example: ovcodautil –ds SCOPE –o CPU –n test.hp.com -obj 

 
3. To dump last data for a data source and a class 

Command: ovcodautil –ds <datasource> –o <class> –n <hostname> -m 
<comma_separated_metrics> -last 
Example:  ovcodautil –ds SCOPE –o CPU –n test.hp.com -m BYCPU_ID, BYCPU_STATE 
–last 

 
4. To dump first data for a data source and a class 

Command: ovcodautil –ds <datasource> –o <class> –n <hostname> -m 
<comma_separated_metrics> -first 
Example: ovcodautil –ds SCOPE –o CPU –n test.hp.com -m BYCPU_ID, BYCPU_STATE 
–first 

 
5. To dump last hours  summarized (by five min) data for a data source and class 

Command: ovcodautil –ds <datasource> –o <class> –n <hostname> -m 
<comma_separated_metrics_list> -b <mm/dd/yyyy.hh:mi:ss> -e <mm/dd/yyyy.hh:mi:ss> -s 
fivemin 
Example: ovcodautil –ds SCOPE –o CPU –n test.hp.com -m BYCPU_ID, BYCPU_STATE  
-b 07/18/2012.10:00:00 -e 07/18/2012.11:00:00 -s fivemin 

 
6. To dump last hours raw data for a data source and class 

Command: ovcodautil –ds <datasource> –o <class> –n <hostname> -m 
<comma_separated_metrics_list> -b <mm/dd/yyyy.hh:mi:ss> -e <mm/dd/yyyy.hh:mi:ss> -
raw 
Example: ovcodautil –ds SCOPE –o CPU –n test.hp.com -m BYCPU_ID, BYCPU_STATE  
-b 07/18/2012.10:00:00 -e 07/18/2012.11:00:00 –raw 

 
7. To dump last hours summarized (by five min) data for a data source and class in a CSV 

format 
Command: ovcodautil –ds <datasource> –o <class> –n <hostname> -m 
<comma_separated_metrics_list> -b <mm/dd/yyyy.hh:mi:ss> -e <mm/dd/yyyy.hh:mi:ss> -s 
fivemin -l "," > file.csv 
Example: ovcodautil –ds SCOPE –o CPU –n test.hp.com -m BYCPU_ID, BYCPU_STATE  
-b 07/18/2012.10:00:00 -e 07/18/2012.11:00:00 -s fivemin > cpu.csv 

  

How to troubleshoot connectivity issues 

Follow the steps mentioned below to check the reachability and availability of data source for 
reporting. 
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1. Check that the host is reachable 
ping -n <hostname> 
If ping fails, check the connectivity to the host. 

Note: If the node is behind a firewall, ping might be blocked. 
 

2. Check to see if the agent is up and running using following command. 
 
ovcodautil -ping -n <hostname> 
 

 

 
Ping of OvBbcCb and Coda should be successful. But if the ovcodautil ping fails 
check the status of agent by running ovc -status command on the agent system and 
check that all the services are running as shown in sample output below 

 

 

How to troubleshoot when there is no CPU data on reports for the past 
2 days 

Follow the steps mentioned below to debug data availability on source. 
1. Check that the host is reachable 

ping -n <hostname> 
If ping fails, check the connectivity to the host. 
Note: If the node is behind a firewall, ping might be blocked. 
 

2. Check to see if the agent is up and running using following command. 
ovcodautil -ping -n <hostname> 
 

 

 
Ping of OvBbcCb and Coda should be successful. But if the ovcodautil ping fails 
check the status of agent by running ovc -status command on the agent system and 
check that all the services are running as shown in sample output below 

 

 
3. Check to see if there is data collected and logged in OA/PA by running following 

command. 
ovcodautil -ds SCOPE -o CPU -m BYCPU_ID,BYCPU_CPU_TOTAL_UTIL -h -last -n 
<hostname> 
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ovcodautil -ds SCOPE -o CPU -m BYCPU_ID,BYCPU_CPU_TOTAL_UTIL -h -last –n 
test.example.hp.com 
 
             Time          CPU              Total 
            Stamp           ID              CPU % 
03/26/12 5:05:00        0                     0.78 
03/26/12 5:05:00        1                     1.92 
03/26/12 5:05:00        2                     2.33 
03/26/12 5:05:00        3                     2.07 
03/26/12 5:05:00        4                     1.19 
03/26/12 5:05:00        5                     2.45 
03/26/12 5:05:00        6                     1.17 
03/26/12 5:05:00        7                     1.10 

          If you don’t see data in last 2 days please contact HP Support 

How to troubleshoot data holes on reports 

Follow the steps mentioned below to debug data availability on source. 
1. Check that the host is reachable 

ping -n <hostname> 
If ping fails, check the connectivity to the host. 
Note: If the node is behind a firewall, ping might be blocked. 
 

2. Check to see if the agent is up and running using following command. 
ovcodautil -ping -n <hostname> 
 
 
Ping of OvBbcCb and Coda should be successful. But if the ovcodautil ping fails check 
the status of agent by running ovc -status command on the agent system and check 
that all the services are running as shown in sample output below 

 

 
3. Run the following command to check if you have one row every five minutes between 

the given start and end time. Start and end time format are mm/dd/yyyy.hh:mi:ss 
ovcodautil -ds SCOPE -o GLOBAL -m 
GBL_MEM_UTIL,GBL_CPU_TOTAL_UTIL,GBL_DISK_UTIL -h -b 
03/25/2013.10:00:00 -e 03/25/2013.11:00:00 -n  test.example.com 
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How to troubleshoot missing dimensions - SHR shows one instance 
even if there are multiple instances 

Follow the steps mentioned below to debug data availability on source. 
1. Check that the host is reachable 

ping -n <hostname> 
If ping fails, check the connectivity to the host. 
Note: If the node is behind a firewall, ping might be blocked. 

 
2. Check to see if the agent is up and running using following command. 

ovcodautil -ping -n <hostname> 
 
 

Ping of OvBbcCb and Coda should be successful. But if the ovcodautil ping fails check the 
status of agent by running ovc -status command on the agent system and check that all the 
services are running as shown in sample output below 

 

 
3. Check that there are KEY metrics by running following command 

ovcodautil -ds DBSPI_ORA_REPORT -o DBSPI_ORA_REPORT -obj -n 
test.example.com 
DBSPI_ORA_REPORT      KEY   UTF8  INSTANCENAME 
DBSPI_ORA_REPORT      KEY   R64   METRICID 
DBSPI_ORA_REPORT      KEY   R64   VALUEID 
DBSPI_ORA_REPORT      GGE   R64   VALUE 
DBSPI_ORA_REPORT      KEY   UTF8  SYSTEMID 
DBSPI_ORA_REPORT      KEY   UTF8  OBJECTID 

  
If there are "NON" instead of "KEY" than SPI is not configured for multiple instances data 
logging to CODA. This would result in data loss. Same step would apply to any Agent SPIs 
To switch the Data logging from DSI and CODA, create following file 
%OVDATADIR\conf\dsi2ddf\nocoda.opt 
Note: By default, nocoda.opt will not be present.  
 
Presence of nocoda.opt file implies that all the data is getting logged in to CODA (except 
the datasources that are specified in the nocoda.opt file). 
Absence of the nocoda.opt file implies that all the data is getting logged into DSI.  SHR 
does not support multi-instance data logging to DSI. 
 

4 Check that the last logged data time stamp for each of the instance. Check that all missing 
instances are listed and there data time stamp is same as with the instance which shows 
up data in SHR. 
 
ovcodautil -ds DBSPI_ORA_REPORT -o DBSPI_ORA_REPORT -last -flat -n <hostname> 
C:\>ovcodautil -ds DBSPI_ORA_REPORT -o DBSPI_ORA_REPORT -last -flat -n  
USNYCDBS 
TEST.EXAMPLE.COM 
=== 03/26/13 9:15:00 PM 
Instance                            : 0 
INSTANCENAME              : p123 
METRICID                          : 119.00 
VALUEID                            : 1.00 
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VALUE                                : 109.71 
SYSTEMID                          : test.example.com 
OBJECTID                           : p123 
   
=== 03/26/13 9:15:00 PM 
Instance                           : 1 
INSTANCENAME             : p123 
METRICID                         : 201.00 
VALUEID                           : 1.00 
VALUE                               : 5.00 
SYSTEMID                         : test.example.com 
OBJECTID                          : p123 

 

How to troubleshoot data collection problems 

Description: Data collection in SHR fails with an Address already in use error logged in 
the topologycollector.log file. 

Resolution: This error occurs when the number of TCP/IP ports used exceeds the default value of 
5000. To resolve this problem, you must make some changes in the Windows Registry. Follow 
these steps: 

1. Click Start > Run. The Run dialog box opens. 

2. In the Open box, type regedit. The Registry Editor window opens. 

3. On the left pane, expand HKEY_LOCAL_MACHINE, expand SYSTEM, expand 
CurrentControlSet, expand Services, expand Tcpip, and then click Parameters. 

4. On the right pane, right-click anywhere, point to New, and then click DWORD Value to add a 
new entry. Add the following entries: 

 MaxUserPort = 65535 (decimal) 

 MaxFreeTcbs = 65535 (decimal) 

 MaxHashTableSize = 65535 (decimal) 

 TcpTimedWaitDelay = 30 (decimal) 

Restart your system after making the changes in the Registry Editor. 

Troubleshooting RTSM Issues 

How to troubleshoot RTSM connectivity issues 

Resolution: If it’s a BSM distributed setup, please ensure that you have provide hostname and 
port of the Data Processing Server and not of the Gateway Server 

How to troubleshoot issues when SHR does not collect data from all 
RTSM-discovered HP Operations agent nodes 

1. Login to BSM console using following URL:  
 http://<hostname>/topaz 

2. Navigate to Admin->RTSM Administration. 
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3. Navigate to Modeling Studio. 

 
4. On the modeling studio page, go to the Resources tab, expand HP-SHR folder -> SM -

> SM_PA, and then double-click on SM_PA view.  
5. In the left pane, the view appears. Click on the calculator icon on the top of the left 

pane and check how many instances of the CI Type "Computer" are available.  
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6. In the sample shown above, there are 28 instances of the CI Type "Computer." This 
means there should be 28 agent data sources from where SHR collects performance 
metrics and reports on System Infrastructure Management. 

  

How to find attribute value for the "HP Operations Agent" CI type 

1. Right click on "Computer" and select "Show Element Instances." You will see a popup 
window that shows the CIs and their attributes. 

 
 

2. If the "PrimaryDnsName" attribute of the "Computer" CI type is blank for a CI (host) in that 
view , then that CI (or host) will not be configured for performance metrics collection 

  

Troubleshooting BPM/RUM issues 

How to check whether BPM agents are configured 

1. Login to BSM console using following URL: 
http://<hostname>/topaz 

 
2. Go to Admin-> End User Management 
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3. Navigate to Settings -> select Business Process Monitor Settings and select BPM Agents. 
  

 
  

4. Check that BPM agents are configured in BSM 
  

How to check whether RUM agents are configured 

1. Login to BSM console using following URL: 
 http://<hostname>/topaz 

2. Go to Admin-> End User Management 
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3. Navigate to Settings ->  Real User Monitoring Settings and select RUM Engines. 

 
  

4. Check that the RUM engine is configured in BSM. 
 

How to check data availability for reporting in BPM 

SHR collects data for reporting on BPM performance metrics from profile database. So data 
availability should be checked in profile database. 
SHR uses Profile DBCollector to get data from the profile database and generate CSV files that will 
later be consumed by the ETL streams for transformation and loading. DBCollector has two 
approaches to query data from source database and generates CSVs.  
The collection policy decides on which approach to follow to generate CSVs. 
 
Two-step process to generate CSVs: 

1. The collector queries the profile database and creates a replica of source database tables 
in SHR’s Sybase IQ database. 

2. SHR performs a join query within the source database replica and generates CSVs. 
One-step process to generate CSVs: 
SHR queries each table individually and incrementally for creating the replica in the SHR Sybase 
IQ database. For the dimension table, SHR gets full table data, but for the fact tables, SHR uses 
the incremental data. 
SHR uses SAMPLETIME column from all the fact tables/view to perform incremental collection to 
get two hour worth of data every hour. It queries one hour of duplicate data every hour to 
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accommodate late-arriving data in the profile database. The SAMPLETIME column in the profile 
database holds time in UTC (seconds from 1/1/1970 00:00:00).  
SHR retains the latest SAMPLETIME column value from each collection cycle for each fact table 
separately and uses that in the next run as the starting point for collection. 
Use following command to generate the queries that SHR fires on the profile database to get data: 
shr_utility –getQueries  {PMDB_HOME}/lib/bpm_dbcollector.xml 
This command generates the queries that you can run on the source profile database to  check for 
availability of data. 

How to check data availability for reporting in RUM  

SHR collects data for reporting on RUM performance metrics from the profile database. Therefore, 
the data availability should be checked in the profile database. 
SHR uses Profile DBCollector to get data from the profile database and generate CSVs that will 
later be consumed by the ETL streams for transformation and loading 
DBCollector has two approaches to query data from source database and generates CSVs.  
The collection policy decides on which approach to follow to generate CSVs. 
 
Two-step process to generate CSVs: 

1. The collector queries the profile database and creates a replica of source database tables 
in SHR’s Sybase IQ database. 

2. SHR performs a join query within the source database replica and generates CSVs. 
One-step process to generate CSVs: 
SHR queries each table individually and incrementally for creating the replica in the SHR Sybase 
IQ database. For the dimension table, SHR gets full table data, but for the fact tables, SHR uses 
the incremental data. 
SHR uses SAMPLETIME column from all the fact tables/view to perform incremental collection to 
get two hours’ worth of data every hour. It queries one hour of duplicate data every hour to 
accommodate late-arriving data in the profile database. The SAMPLETIME column in the profile 
database holds time in UTC (seconds from 1/1/1970 00:00:00).  
SHR retains the latest SAMPLETIME column value from each collection cycle for each of the fact 
table separately and uses this in the next run as the starting point for collection. 
Use following command to generate the queries that SHR sends to the profile database to get data: 
shr_utility –getQueries  {PMDB_HOME}/lib/RUM_dbcollector.xml 
This command generates the queries that you can run in the source profile database and check for 
the availability of data. 

Troubleshooting HP SiteScope Issues 

How many Site Scope servers is SHR reporting on? 

1. Log on to the BSM admin console by using the following URL: 
http://<bsm_host_name>/topaz 

2. Navigate to Admin->RTSM Administration 

 
 

Page 46 of 52 



Troubleshooting Guide 
Troubleshooting data source-related issues 

3. Navigate to Modeling Studio 

 
 
4. On the modeling studio page, go to the Resources tab and expand HP-SHR folder -> SM -

> SM_SiS_Server and double click on SM_SiS_Server view.  
 

5. In the right pane with view details, the instances of CI Type "Computer" indicate the 
number of Site Scope servers that SHR gets in to for reporting. 
 

 

 
6. To check details of SiteScope servers, right-click on the "Computer" CI type, and then 

select "Show Element Instances." Check the PrimaryDnsName attribute. SHR uses this 
attribute to configure collection and get the performance metrics of the remote servers 
configured in SiteScope. 
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How many servers (Windows/UNIX) does SiteScope monitor? 

1. Log on to SiteScope using the following URL: 
http://<hostname>:8080/SiteScope/servlet 

2. Go to Remote Server 

 
  

How to check that BSM integration is enabled in SiteScope? 

1. Log on to the SiteScope home page. 
2. Go to Preferences-> Integration Preferences. 
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3. An integration entry for BSM will appear once SiteScope is added in BSM. 

 
  

 
  
All managed nodes from SiteScope will be automatically synchronized to BSM once the 
integration is complete. You can perform the Re-Synchronize or Hard Re-Synchronize action 
if required. 
  

How to check that CODA integration is enabled in SiteScope 

1. Log on to the SiteScope home page. 
2. Go to Preferences - Integration Preferences. 
3. An integration entry for BSM will appear once SiteScope is integrated with CODA. 

 
4. If the integration is not listed in the above screen, click on the * icon and select “HP 

Operations Manager Integration.” 
 

Enable SiteScope to integrate with the HP Operations agent for data logging.  
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How to check the availability of the SiteScope performance data in 
CODA 

SHR Queries the CODA data store running on Site Scope server to get performance metrics for 
reporting. 
SHR queries the following classes within the “AGENTLESS” data source to get the performance 
data: 

a. GLOBAL 
b. MEMORY 
c. DISK 
d. SYSTEM 
e. QUEUE__LENGTH 
f. QUEUE__STATISTICS 
g. UPTIME 
h. PHYSICALDISK 
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i. IO__STATS 
j. NETIF 
k. NETWORK__INTERFACE 
l. NETWORK__STATS 
m. CPU 
n. FILESYSTEM 

Refer to Troubleshooting HP Operations agent data source issues for details on how to check 
availability of a class and a data source. 
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